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About this Manual
Legal Notices
1  About this Manual

This manual describes how to install, configure and upgrade an FastViewer 
system as independent web conferencing solution.

1.1  Legal Notices

FastViewer GmbH assumes no liability for any damage, loss or destruction of 
software, data or programs resulting from the use of FastViewer.

The software and hardware designations used in this manual are mostly regis-
tered trademarks and thus subject to the relevant provisions of copyright law. The 
documentation, as well as extracts from it, may be neither transmitted nor repro-
duced by any mechanical or electronic means, photocopying or any other means 
without express permission in writing. All company names cited in examples and 
data are fictitious. Any similarities are therefore purely coincidental.

The information contained in this document is based on the current software 
version used at press time. This may be changed at any time without notice and 
represents no commitment on the part of the seller. The descriptions herein do not 
guarantee the availability of any described features in a legal sense.

FastViewer has exercised the utmost care while preparing this guide, but does not 
warrant the completeness or accuracy of the information in it and disclaims all 
liabilities for any technical or printing error.

As far as possible, this document is gender neutral. In cases where the masculine 
form of address is used, this is done solely for simplicity, and the feminine form is 
always implicitly included.

If you have corrections or suggestions, please send us an e-mail.

Thank you for your efforts.

More information on the FastViewer products can be found in the Internet at

www.fastviewer.com

© Copyright FastViewer GmbH

1.2  Technical Assistance

If you require help with a technical problem, please contact our hotline:

Phone: +49 (9181) 509 56 -28

E-Mail: support@FastViewer.com

1.3  Who should read this Manual?

This manual addresses persons who install, configure and manage an 
FastViewer solution as independent web conferencing system.
FastViewer GmbH, 10/2019
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About this Manual
Manual Contents
1.4  Manual Contents

This manual describes how to install and correctly configure FastViewer.

It is structured as follows:

Chapter 1: About this Manual

This chapter contains information about the structure and use of this user guide 
as well as a list of all acronyms used.

Chapter 2: FastViewer - the Web Conferencing Solution

This chapter provides an overview of the FastViewer solution.

Chapter 3: Installation Requirements

This chapter comprises the hardware and software requirements for installing all 
associated components.

Chapter 4: Setting up the FastViewer Server

This chapter describes the WebFastViewer server installation.

Chapter 5: Installing FastViewer Web Client

This chapter describes the installation of FastViewer Web Client, required for the 
web-based access to web conferences.

Chapter 6: Activation of the https support

This chapter describes the activation of the https support. Also the procedure to 
exclusive communication is described in this section

Chapter 7: Administrative Tools

In this chapter you find the administrative tools you can use for connecting SSL 
certificates, analyzing errors, and maintaining FastViewer.

1.5  Representation Conventions

To highlight information in this manual we use the following mark-ups and repre-
sentations.

1.5.1  Notations and Formats

The following format conventions apply in the manual on hand:
 FastViewer GmbH, 10/2019
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Representation Conventions
1.5.2  Hints

Type of Notes

In this manual, we denote critical hints and supplementing information in the 
following way.

NOTICE:  Denotes hints that contain information worth knowing 
or useful tips.

IMPORTANT:  Denotes critical hints that contain high-priority 
information. Please definitely read such hints and follow given 
instructions to avoid malfunctions, loss of data or damage to 
devices.

1.5.3  Figures

This manual displays all input windows important for operation and configuration. 
Depending on the operating system, the browser used, the screen resolution, the 
configurations of your PC or your selection of the interface style, the appearance 
of such windows may vary. However, this does not affect the described function-
ality.

Purpose Representation Example

Product and company names Italic Fastviewer

Special highlighting Bold Name must not be deleted.

GUI elements Bold Click on OK.

Menu sequence  > File > Exit

Cross reference Italic You find further information in the Configura-
tion and Administration manual.

Path and file names Fixed-width font, for example 
Courier

c:\Programs\... or example.txt

Specifications that may have an individual 
content such as variables.

Italic in pointed brackets Specify your <user name> and <password> for 
logging on to the system.

System in- and output Fixed-width font, for example 
Courier

Command not found.

Hotkey Bold [Ctrl]+[Alt]+[Esc]
FastViewer GmbH, 10/2019
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About this Manual
Acronyms
1.6  Acronyms

Table:  Acronyms used

1.7  System Requirements for the FastViewer Clients

Hardware and software requirements for using FastViewer.

In the following chapters you find the system requirements for:

• Clients based on Microsoft Windows operating systems

• Clients based on Apple operating systems OS X

• Web browsers usable as a client

• Mobile devices usable as a client

1.7.1  System Requirements for Windows Clients

The following system requirements apply for operating the master module 
FastMaster.exe and the client module FastClient.exe of FastViewer:

Acronym Meaning

CLA Customer License Agent

CLM Customer License Management

DMZ Demilitarized Zone

FQDN Fully Qualified Domain Name

IIS Internet Information Services

OEM Original Equipment Manufacturer

WCF Windows Communication Foundation
 FastViewer GmbH, 10/2019
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About this Manual
System Requirements for the FastViewer Clients
1.7.2  System Requirements for Apple OS X Clients

The following system requirements apply for operating the master module 
FastMaster.app and the client module FastClient.app of FastViewer:

Operating system Windows Vista

Windows 7

Windows 8

Windows 8.1

Windows 10

Windows Server 2008

Windows Server 2008 R2

Windows Server 2012

Windows Server 2012 R2

Windows Server 2016

Windows Server 2019

 

But only maintained:

Windows 7

Windows 8

Windows 8.1

Windows 10

Windows Server 2012 R2

Windows Server 2016

Windows Server 2019

System requirement Internet access

Recommended system requirement Internet access with DSL 2000 kbit/s

Operating system Apple OS X Yosemite 10.10

Apple OS X El Capitan 10.11

Apple macOS Sierra 10.12

Apple macOS High Sierra 10.13

Apple macOS Mojave 10.14

System requirement Internet access

Recommended system requirement Internet access with DSL 2000 kbit/s
FastViewer GmbH, 10/2019
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1.7.3  System Requirements for FastViewer WebClient

You can use the following web browsers for FastViewer WebClient:

1.7.4  System Requirements for Mobile Devices with Android or Apple iOS

Operation on mobile devices requires the following:

Webbrowser (Java) Internet Explorer version 8 oder newer-
Mozilla FirefoxGoogle Chrome version 24 
or newerSafariOpera

System requirement Internet access

Recommended system requirement Internet access with DSL 2000 kbit/s

Mobile operating system min. iOS 8 or later

min. Android 4.1 or later
 FastViewer GmbH, 10/2019
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FastViewer - the Web Conferencing Solution
System Requirements for the FastViewer Clients
2  FastViewer - the Web Conferencing Solution

FastViewer is a web conferencing solution that, owing to its scalability, high 
security and reliability, enables comprehensive multi-media collaboration. It is 
suitable for companies of all sizes and offers the option to stage web conferences 
with up to 100 participants.

FastViewer recognizes the operating system's language automatically. Secure 
transmission of all session data is ensured by a 256-bit AES encryption.
FastViewer GmbH, 10/2019
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Minimum Installation Requirements
System Requirements for the FastViewer Clients
3  Minimum Installation Requirements

In the following we list the hardware and software requirements that the system 
to host FastViewer must comply with.

Minimum requirements for the installation for setting up the FastViewer 
server for up to 100 simultaneous users

• Xeon processor with at least 2,5GHz clock frequency

• At least 4 GB RAM (recommended: 8 GB)

• At least 30GB free harddisk memory

• 1Gbit network board

• Operating systems:

– Microsoft Windows Server 2012 R2, Standard Edition

– Microsoft Windows Server 2016, Standard Edition

• Database:

– Microsoft SQL Server 2008 Express Edition (is included) or newer

• Bandwidth requirement
Bandwidth consumption per FastViewer session depends on the connection 
type:

– Connections with desktop sharing
Such connections require an average of 15kbit/s per participant.

– Connections with video streaming
Depending on the image quality settings in the GUI, up to 300 kbit/s are 
required per user.

– Voice connections
Connections with voice transmission require an average of 20kbit/s per 
user.

• The FastViewer server is found in a DMZ (Demilitarized Zone). The server 
requires an IP address or alternatively a DNS host entry pointing to the corre-
sponding IP address. 

NOTICE:  When configuring the FastViewer server, prefer the fully 
qualified domain name (FQDN) to the IP address. If you use for 
example the IP address and it is changed, existing web confer-
ences are not updated to the new IP address and cannot be 
started anymore.

• Port releases
In order to guarantee the WebConfence to be reachable via LAN or Internet, 
the following ports must be opened in a firewall and must not be used exclu-
sively by another program or service:

– HTTP port: 80

– HTTPS port: 443 (Only if a certificate is used)
 FastViewer GmbH, 10/2019
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Minimum Installation Requirements
System Requirements for the FastViewer Clients
– TCP port: 5000
Port 5000 ensures sessions on highest performance level.
This port must be opened when video functions are used (sending / 
receiving WebCam pictures).

NOTICE:  The usage of the certificate Installer for linkage of an 
SSL-certificate requires .NET Framework 3.5.

NOTICE:  The HTTP-Protocol is being used to check the 
available servers at module start. When using your own 
FastViewer Server solution this check can be done via HTTPS 
instead of HTTP, the port number can be free selected (e.g. 
HTTPS 321). Thus it is possible to restrict the used protocols and 
the required ports to be opened in order to guarantee the own 
security standards. A description of the single configuration steps 
can be found in chapter 6.5 Steps for exclusive usage of https.

• You can install the FastViewer server in a VMware ESX(i) 4.x and 5.x 
environment.

Requirements for setting up FastViewer WebClient

• Operating systems:

– Microsoft Windows Server 2012 R2, Standard Edition

– Microsoft Windows Server 2016, Standard Edition

– Microsoft Windows Server 2019

• Microsoft .NET Framework 3.5 SP1 is installed on the system.

• Webserver (IIS) is installed on the system

• Supported web browsers - all web browsers with JavaScript support, for 
example:

– Internet Explorer from version 8

– Mozilla Firefox

– Apple Safari

– Google Chrome

– Opera

• You can install the FastViewer server in a VMware ESX(i) 5.x and 6.x 
environment.
FastViewer GmbH, 10/2019
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Installing the FastViewer Server
Diagram for Hosted Version
4  Installing the FastViewer Server

This chapter describes the preparation steps you need to take to set up the 
FastViewer server module and illustrates the setup process.

You can download the software to be installed fast and conveniently from the 
customer portal, or it is provided to you on a data carrier.

You reach the FastViewer customer portal via the following link: 

https://portal.fastviewer.com

In there you can log on to the portal with your alias name or serial number and the 
associated password.

The customer portal provides the following functions:

• Displaying and editing private data related to the purchased license.

• Performing program settings for configuring the master and client module.

• Downloading and viewing various documents and documentation on the 
product.

• Downloading all modules of the product FastViewer to provide them for the 
installation: 

– The master module for Microsoft Windows or Mac operating systems

– The client module for Microsoft Windows or Mac operating systems

– The WebCollaboration modules.

– The setup directory for the FastViewer Outlook Plugin.

– The setup for the FastViewer server.

– The update files for the FastViewer server.

– The setup for the FastViewer WebClient.

• Displaying information about all currently installed Secure Advisor clients as 
well as all active connections.

4.1  Diagram for Hosted Version

Description and configuration of the Hosted Version for FastViewer.

The Hosted Version (cloud solution) is another option for a customer deployment 
to use features provided via the FastViewer. The following diagram illustrates how 
such a deployment scenario looks like:
 FastViewer GmbH, 10/2019
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Installing the FastViewer Server
Download the Installation File for the Server Installation
If there is no individual FastViewer server license for an on-site installation of an 
FastViewer server, web conference sessions are automatically staged via a 
hosted server infrastructure. This infrastructure is distributed globally and 
designed highly redundantly for secure operation.

All you need to do is logging on to the FastViewer customer portal with the basic 
license and downloading the corresponding master and client modules.

Before you download the moderator and client modules you may customize them 
via the configuration settings in the portal.

4.2   Download the Installation File for the Server Installation

Downloading the installation file for the server installation.

To download the installation file for the server installation and to provide it for the 
installation proceed as follows:

Step by Step

1) Invoke the following internet page:

https://portal.fastviewer.com

The page on which you can enter the account data to download the 
components for FastViewer opens.
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2) To log on for the first time, enter your license number for accessing this web 
portal under Alias/Serial. 

3) Specify your password for accessing this web portal under Password.

4) Click on the Login button.

The start page of the customer portal opens.

5) Click on the Switch to expert mode button in the menu bar.

You see your account data as well as the status of your license.
 FastViewer GmbH, 10/2019
12 FastViewer V3.2 Server Solution, Installation and Configuration, Manual



Installing the FastViewer Server
Download the Installation File for the Server Installation
6) Click on the Download button.

The following page is displayed:
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7) Expand the displayed list with a click on the small triangle bottom left of Type: 
Own server solution.

8) Click on the Download link next to Download Server Setup.

A file download dialog opens.

9) Click on OK in the file download dialog.

Downloading the ServerSetupV32.zip file starts.

Downloading the installation file for the FastViewer server is now complete.

4.3  FastViewer Server Setup

The following is a step-by-step guide through the setup process. Depending on 
the purchased license, various editions with different features and functions are 
available to you after the installation. 

Execute the following setup steps:
 FastViewer GmbH, 10/2019
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Step by Step

1) Extract the downloaded file ServerSetupV32.zip in the desired folder on 
the FastViewer computer.

2) Execute the setup.exe file.

NOTICE:  Be sure to execute the file with administrator privileges. 
Depending on the operating system, you may then have to right-
click the file and select Run as Administrator.

3) Click on Next.

4) The opened dialog lists all required applications that are not present on the 
system, for example:

• .NET Framework 4.0

• Various Windows Installers
FastViewer GmbH, 10/2019
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• Microsoft SQL Server 2008 Express SP2

5) Click on Next.

When the required software is installed, the dialog closes and the FastViewer 
server setup starts automatically.

6) Click on Next.
 FastViewer GmbH, 10/2019
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7) Use the default-set destination folder for the installation or select one via the 
Browse... button.

8) Then click on Install.

The application is being installed.

9) When the setup is finished, click on Finish.
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The setup process is successfully accomplished. The dialog closes. The 
Webconferenceserver service starts automatically after the installation.

4.4  Adaption of settings.ini

After you have installed the FastViewer server, execute the following steps to 
configure it:

NOTICE:  If you want to offer participants the possibility to partic-
ipate via browser in sessions, then a WebClient Server is 
required.

Step by Step

1) Open the settings.ini file in the setup folder of the FastViewer server in 
an editor.

By default, this file is found under the path:

C:\Program Files (x86)\WebConferenceServer

2) Search the following line:

ExternalAddress=Change2YourServer

3) Replace value Change2YourServer with the external, fully qualified domain 
name (FQDN) of the FastViewer server.

ExternalAddress=webconf1.example.com

4) Search the following line:

;ClientURLBase=http://Change2YourServer/client/
fastclient_i_%1.exe
 FastViewer GmbH, 10/2019
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5) Replace value Change2YourServer in both lines with the external, fully 
qualified domain name (FQDN) of the FastViewer server computer. For 
example:

and for the possibly configured second URL:

6) Remove the semicolon (;) at the beginning of the line.

As a result, the line and thus also the parameter you have defined become 
valid.

7) Rename the Servername parameter optionally.

NOTICE:  You are free to choose any name for the Servername 
parameter. The specified name is displayed at the call of the DNS 
Name / IP Address via the browser.

8) Creation of the listeners: If the server should be available via two DNS names 
(this is the case if the FastViewer WebClient is operated on the same server, 
but should be reachable also with another DNS Name) perform the following 
settings: 

NOTICE:  If this is not the case, you must not change the defaults.

9) Search the following lines:

listen1="http://*/"

listen2="https://*/"

Replace the asteriks (*) with the DNS Name under which the FastViewer is 
reachable, e.g.

listen1="http://webconf1.example.com/"

listen2="https://webconf1.example.com/"

10) Supplement the list points by:

 listen3="http://localhost"

11) Save your changes and close the settings.ini file.

12) Terminate the Webconference server service via Windows Server Manager.

13) Start the Webconference server service.

The settings.ini file may look like this:

;ClientURLBase=http://webconf1.example.com/client/fastclient_i_%1.exe

WebclientURLBase=http://10.1.101.2:8080/joinclient.aspx?inv=%1

; Name of server (for database connection entries)

ServerName=WEBCONF1

; SQL Connection string, the password for user sa is encrypted, so it cannot be used for 
login in an interactive SQL manager session
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SQLConnectionString="Data Source=(local)\fastviewer;Initial Catalog=fastviewer;Persist 
Security Info=True;User ID=sa;Password=<<ZLY5VPd8byicus01ottxqQ==>>"

; Session ID Start value for that server

SessionIDStart=100000

; Session ID End value for that server

SessionIDEnd=999999

ExternalAddress=10.1.101.2

XMLRPCsecure=true (insert when using the Outlook add-in)

XMLRPCsecureFQDN=<host.yourdomain.com> (insert when using the Outlook add-in; please enter 
the FQDN of the FastViewer server for host.yourdomain.com).

[Logging]

; The setting value is the limit at which a log message is logged.

; 0=Info, 1=Uncritical, 2=Warning, 3=Important, 4=Critical, 5=Disabled

;All=0 ; this overwrites all others, if less

;Connection=2

;PacketManager=2

;DatabaseManager=2

;General=2

;License=2

;MessageProtocol=2

;SessionManager=2

;XmlProtocol=2

; Log file path and logfilename

;LogFilePath="tunnelserver.log"

;MaxLogFileSizeMB=100

; How many logfiles should exist before overwritten

;RotationNumberOfFiles=3

[HttpListenURLs]

; This section contains a list of URLs where the HTTP Service should listen (Hostheader).

; This is required not only for HTTP downloads but also for normal HTTP communication!

; SSL Listenings should also be added here.

listen1="http://*/"

listen2="https://*/"

[ConnectionManager]
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You must activate the FastViewer server after its configuration.

To authenticate the FastViewer server to the SQL database, the "mixed mode" 
can be used. Thus, a registration via AD account is possible. Access is always via 
the connection string entered in the settings.ini.

In this case, the FastViewer service must run under an ActiveDirectory account 
that is also authorized for the database. It is identical with the user who runs the 
Logviewer.

 

Description of the possible settings.ini parameters:

RootURLreply=<Webconference Server>

[SessionManager]

ClientURLBase=http://10.1.101.2/client/fastclient_i_%1.exe

WebclientURLBase=http://10.1.101.2:8080/joinclient.aspx?inv=%1

; You can use SingleURL=true only if the webclient is installed, then all XMLRPC answers are 
with the webclient URL.

SingleURL=false

[DatabaseManager]

;BackupPath="c:\sqlbackup"

;BackupHourUTC=1

Login with username / password:

SQLConnectionString=“Data Source=db.yourdomain.com;Initial Catalog=fastviewer;Per-
sist Security Info=True;User ID=sa;Password=xxxxxxx”

integrated login with security:

SQLConnectionString=“Data Source=db.yourdomain.com;Initial Catalog=fast-
viewer;Integrated Security=SSPI”
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Section Parameter name Description

[General] Servername = "WEBCONF1" Name of the Server 
– is displayed at call 
of the page http://
localhost/admin.

SQLConnectionString = "Data 
Source=(local)\fastviewerInitial Cata-
log=fastviewerIntegrated Security=True"

The Connection-
String contains infor-
mation about 
Database connec-
tion with which the 
Server can connect 
to the Database.

SessionIDStart = 100000 SessionIDEnd = 
999999

Start and End of 
range from the 
server administrated 
Session IDs. (Rele-
vant if you use sev-
eral servers)

ExternalAddress = "http://FQDN/" FQDN (Fully Quali-
fied Domain Name) 
or IP under which 
the server is reach-
able internally and 
externally. If there is 
only an explicitly 
internal soltution, 
then it is sufficient 
that the server is 
reachable only inter-
nally.

UpdateURL = "http://update1.fast-
viewer.com/download/"

From this URL the 
AutoUpdates and 
RE Updates are 
downloaded. Please 
consider that a sub-
directory must exist 
with the respective 
version name (e.g. 
3.20.0039) and it 
must contain the 
update-files. The 
update-files can be 
obtained from the 
personal Fast-
Viewer portal.

XMLRPCSecure = false Activates the Lis-
tener for the XMLR-
PCSecure Interface. 
This requires SSL 
and thus a SSL Cer-
tificate!
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XMLRPCSecurePort = 5100 Defines the Port 
5100 for the Lis-
tener of the XMLR-
PCSecure interface. 

XMLRPCSecureFQDN = "localhost" Defines the FQDN 
(Fully Qualified 
Domain Name) for 
the XMLRPCSecure 
interface.

LogVerboseLevel = 10 A general Logging-
level, from which the 
standard value of the 
„[Logging]All“ param-
eter is calculated.

[Logging] All = 2 Increments equally 
the LoggingLevel for 
all sections. (Possi-
ble values 0 to 5) 
The less the Loggin-
gLevel the more 
detailed is the Log-
ging.

?Connection = 2PacketManager = 
2DatabaseManager = 2General = 2License 
= 2MessageProtocol = 2SessionManager = 
2XmlProtocol = 2XmlRpc = 2Services = 2

Here the specific 
Logginglevel for sep-
arate sections can 
be adapted.

LogFilePath = "tunnelserver.log" Name of the Logfile.

MaxLogFileSizeMB = 100 Maximum size 
(specified in MB) of 
the log file before it 
is rotated. With rota-
tion a new log file is 
created.

RotationNumberOfFiles = 3 Maximum Number of 
rotation files before 
the oldest logfile will 
be overwritten.

SyslogServer = ""SyslogPort = 514 Here the Name and 
Port of a Syslog 
server can be 
defined to which the 
Syslog messages 
will be sent.

[HttpListenURLs] 
(List)

Listen = "http://*/" List of the Listeners 
which should be initi-
ated by the Server. 
Default: http-Listener 
/ Standardport 80 / 
0.0.0.0

Section Parameter name Description
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[ConnectionMan-
ager]

RootURLReply = "fastViewer WebConfer-
ence Server"

Here the Response 
for a "common" http 
Request, like e.g. via 
a Browser can be 
specified.

DirectListenIP = "" Here an IP can be 
entered on which the 
DirectListener is 
established. if 
empty: 0.0.0.0

DirectPort = 5000 Here the Port for the 
Direct-Listener is 
established.

[SessionManager] ClientURLBase = "http://join.fast-
viewer.com?inv=%1"

Download-Link to 
the Server.

WebClientURLBase = "http://ExternalAd-
dress/client/fv_i_%1.exe"

Download-Link to 
the Webclient.

SingleURL = false If activated, the 
server responds with 
the WebClientURL, 
also even when the 
ClientURL is 
requested.

FileboardPath = ".\fileboard\" The folder in which 
the copied files to 
the fileboard are 
stored.

RecordPath = ".\recordings\" The folder in which 
at Serverside-
recording the rcord-
ings are stored.

AlwaysAllowDowngrade = false Start mit older Ver-
sion allowed? 
(Downgrade)

KeepAliveIntervalSeconds = 5 Interval in which the 
KeepAlive NOOP 
Packages are sent. 
!Attention! Changes 
can cause problems 
with the Firewall.

[DatabaseManager] BackupPath = ""BackupHourUTC = -1 Path and UTC time 
for the automatically 
Database backups

PerformUpdate = false If activated, the 
server is permitted to 
update the Database 
if required. Default: 
false

Section Parameter name Description
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SetMemoryLimitMB = 512 Database Snapshot 
Size. If an own data-
base is used and the 
usage of this param-
eter causes errors 
then this value must 
be set to 0. 

CleanupDeletedHourUTC = hh:mm Time for the data-
base clean up. (For 
deletion marked data 
records will be 
removed)

DBSyncIntervalSeconds = 3 Interval in which the 
Database of the 
servers is synchro-
nized.

BackupPath="c:\sqlbackup"

BackupHourUTC=1

MaxDBLogRetentionDays=80

CleanupDeletedHourUTC=2

MaxDBLogReten-
tionDays=80 (Num-
ber of days after 
which a log entry 
should be deleted)

CleanupDeleted-
HourUTC=2 (Time 
when the deletion 
should be done 
daily.)

[AdminIPList] (List) Allow = "127.0.0.1" Here you can specify 
the IPs from which 
the Admin-HTML-
page can be 
accessed. 127.0.0.1 
will be added 
always.

[HttpServer] CustomizedClientDownload = true Each child license 
can have in the 
defined folder an 
adapted .exe for 
invitations 
(licensenum-
ber.exe) This 
parameter can be 
used exclusively for 
ASP servers.

Section Parameter name Description
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CustomizedClientPath = "clients\" Here you specify the 
folder in which the 
Child FastCli-
ents.exe files will be 
stored. This parame-
ter can be used 
exclusively for ASP 
servers.

[HttpServerPaths] 
(List)

/update/ = ".\update\" Links the update 
folder with the vir-
tual folder /update/

/client/ = ".\fastclient.exe" Links the FastCli-
ent.exe with the 
virtual folder /client/

/old/ = ".\oldversion.exe" Links the oldver-
sion.exe with vir-
tual folder /old/. The 
oldversion.exe 
prints an information 
when the used ver-
sion is an old ver-
sion. (Relevant if the 
"MinVersion-Param-
eter“ is set. Refer to 
parameter descrip-
tion)

[RemoteManager] AutoupdateREExeName = "FastRemoteUp-
date.exe"

Definition of the 
Name for the 
Remoted Update 
file.

AutoRemoveDoubleEntries = false At activation this 
function removes 
automatically dupli-
cate Remote ser-
vice entries.

AutoRemoveDoubleEntriesHourUTC = 1 time for the removal 
of duplicate Remote 
service entries.

AutoupdateTimespanSeconds = 10 Interval between the 
Updates of single 
Remote services, 
when several are 
updated simultane-
ously !Attention! A 
too low value can 
severe affect the 
server performance.

[PortMapper] Enabled = false Block PortMapper on 
the server.

Section Parameter name Description
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[Security] AllowRunningInfo = true Is it allowed to 
retrieve status infor-
mation?

AllowPostAspLicense = false If activated then from 
the ASP service a 
created license via 
the ASP interface 
can be transmitted to 
the server.

AllowClientUpload = false If activated then a 
FastClient.exe 
can be copied to the 
server via a created 
license over the ASP 
interface.

[UserManager] MacMinVersion = "" Here a minimum 
Mac module version 
can be defined. If it 
is attempted to start 
with an older ver-
sion an according 
message is dis-
played. (see also 
parameter /old/ = 
".\oldversion.exe").

MinVersion = "" Here a minimum 
Windows module 
version can be 
defined. If it is 
attempted to start 
with an older ver-
sion an according 
message is dis-
played. (see also 
parameter /old/ = 
".\oldversion.exe").

SMSUrl = "https://sms.fastviewer.com:9710/
http/send-message?user-
name=admin&pass-
word=%p%&to=%mobile%&message-
type=sms.automatic&message=%mes-
sage%"

The URL over which 
the SMS Service is 
controlled.

SMSPassword = "xxxxxxxx" The password for 
the SMS Service.

SMSAuthKeyLength = 5 Length of the 
authentication key 
which will be sent 
per SMS.

Section Parameter name Description
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4.5  Configuration of the server list and Activation of the FastViewer Server

Proceed as follows to activate the FastViewer server:

Step by Step

1) Create in the installation directory (C:\Program Files (x86)\WebConference-
Server) a new folder and name it update.

2) Add a new text file with the name serverlist.txt to the folder.

3) Define the range of the possible session numbers for your Server (by default 
100000-999999) and enter the external full qualified domain name (FQDN) or 
the IP-addresse of Servers, which you have specified already in "settings.ini" 
e.g.: 100000-999999:webconf1.example.com With the splitting of the 
numbers from 100000 to 999999, e.g. 100000-499999 and 500000-999999, 
more servers can be specified.:

A sample for the text file could look like this:

100000-299999:10.1.101.2

300000-599999:10.1.101.3

600000-999999:10.1.101.4

This file will be created by default in the following path:

the Server list is accessible via https://Servername/update/
serverlist.txt.

4) Click on Start > All Programs > Webconference Server V3 and select the 
Server Manager option from the displayed list.

The Activation Wizard opens.

5) Click on Activate Server and click in the following window on the Use 
Serverlist URL tab.

The following dialog opens:

<Range of the session-IDs>:<DNS-Name of the Server>

C:\Program Files (x86)\WebConferenceServer\update
 FastViewer GmbH, 10/2019
28 FastViewer V3.2 Server Solution, Installation and Configuration, Manual



Installing the FastViewer Server
Configuration of the server list and Activation of the FastViewer Server
6) Specify in the Dialog windos the link to the Server list and click on Validate 
url in order to verify the specified link. (http://YOURSERVER/update/
serverlist.txt)

7) Click on Next.

In the dialog now open you need to decide whether or not to set up a 
connection to the internet.

8) Click on Yes.

The following dialog opens:

9) Enter your License number.

10) Click on Activate.

• If you have an internet connection, your release code is automatically 
entered in the respective field after a short waiting period. A message 
informs you about the successful activation of your FastViewer server.

• However, if you do not have an internet connection or a proxy in use, click 
on the link Create Unlock File.
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Send the created unlock file by e-mail to:

helpdesk@fastviewer.com

You receive the release code within the next 24 hours also by e-mail.

After you have received the file with the release code (for example 
ServerAdmin.fvk), enter the storage location in the Activation File 
input field.

After you have clicked on the Activate button you are informed about the 
activation status of your FastViewer server by a corresponding message.

NOTICE:  In case the message "no more activations available" is 
displayed, then call the support in order to enable activations 
again.

11) Close the message about the activation status of your FastViewer server with 
a click on OK.

The following dialog opens:

In this dialog you need to import the purchased license after successfully 
activating the FastViewer server.

12) Select one of the following options:
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• Use Download

Activate this option if you have an internet connection. In this case the file 
with the release code is automatically downloaded from the activation 
server.

• Use Local File

Activate this option if you do not have an internet access but received the 
file with the release code by e-mail. Then click on the search icon ... for 
specifying the storage location for the file with the release code.

13) Click on the Start Import button.

You are informed about the import status by the following dialog, for example.

14) Click on Exit.

The dialog closes and the Server Management Wizard is shut down.

15) Close the Webconference server service via the Windows Server Manager.

16) Start the Webconference server service.

4.6  Check the accessibilty of FastViewer Server and service configuration

The following steps serve for checking the functionality of the installed and 
activated FastViewer server.

Step by Step

1) Open the following ports in your internal firewall (if active) for the connections 
to the FastViewer server: 

• TCP 5000

• HTTP 80

• HTTPS 443
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2) If the FastViewer server shall also be used by external persons, open in your 
external firewall the following ports for the connections to the FastViewer 
server:

• TCP 5000

• HTTP 80

• HTTPS 443

3) Enter the following link in a web browser on the FastViewer computer.

http://localhost/admin

This enables you to check the server functionality and monitor the server 
service at a later date. Please note that you can invoke monitoring only 
directly at the server for security reasons.

The following web page is displayed for example in the web browser:

4) Start a web browser on a workstation in your network and move to the 
following link:

http://<FQDN name or IP address of your FastViewer server>

You see a web page with the following content: 

fastviewer Webconference Server

IMPORTANT:  If you do not, please check your firewall settings.

Finally, you must perform settings in the restore options of the Webconfer-
enceserver service that concern the case of a service error.

5) Open the dialog that displays local services via Start > Administrative Tools 
> Services.
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6) Open the context menu with a rightclick on the Webconferenceserver 
service.

7) Select Properties from the context menu.

The following dialog opens:

It contains the pre-set values for the combo boxes First failure, Second 
failure and Subsequent failures.

8) Set the Restart the Service option for all three fields.

9) Click on Apply.

Your settings are saved and will be used.

10) Click on OK.

The settings dialog closes.

4.7  Download Master and Client Module

Providing application files for the master and client module.

This section illustrates the steps you need to take after the server activation in the 
customer portal to enable using the master and client module for the FastViewer.

To download the application files for the master and client module (for Microsoft 
Windows or the Mac version in each case) from the FastViewer portal and store 
them on the server, proceed as follows:
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Step by Step

1) In case you are already logged in the portal, please log out.

Invoke the following internet page:

https://portal.fastviewer.com

The web page with the input form for logging on to the portal opens.

2) To log on for the first time, enter your license number for accessing this web 
portal under Alias/Serial. 

3) Specify your password for accessing this web portal under Password.

4) Click on the Login button.

The start page of the customer portal opens.
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5) Click on the Switch to expert mode.

You see your account data as well as the status of your license.
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6) Position the mousepointer on the Settings. (eventually Settings V3)

A selection list opens.

7) Select the Functions option from this list.

The following page is displayed:
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8) To configure the client modules, select an already created profile from the 
combo box next to Chosen Profile or specify a new profile via the Profile 
Manager.

If you use an existing profile, continue downloading the client modules with 
step 13. Otherwise...

9) Access the tabs General, Client Module, Support, Presentation, 
Conference, and Remote to create a new profile. You can then use this 
profile to adjust the master and client module settings to the characteristics of 
your company.
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IMPORTANT:  You cannot change the configuration of the 
Default profile. If you try to save changes to the default profile, an 
error message will appear. 

a) To create a new profile, click on the Profile Manager button.

The Profile Manager dialog opens:

b) Click on the New profile button.

The following dialog opens:

c) Enter the desired profile name in the input line.

d) Click on the Save button.

The new profile has been integrated in the profiles list and is displayed as 
current profile.

e) Click on the (x) icon in the top-right corner of the caption bar.

The Profile Manager dialog closes.

10) Click on download in order to check if the licence has been linked to the 
server. In this case the configured server list is displayed red framed.

11) Perform other changes to the profile settings optionally.

NOTICE:  Between the parameters and the area in which the 
settings are performed you find a round icon with a question mark. 
If you position the mouse pointer on the question mark icon, you 
see a description of this parameter. 

NOTICE:  When you perform the profile settings for user 
languages that can only be represented in UTF-8 (e. g. Russian, 
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Chinese, etc.), you need to select under Switch to: > Texts > 
General the Send invitations via mailto option.

In addition, you need to set the international options in 
Microsoft Outlook and in the Internet Explorer to UTF-8 for such 
languages if this has not been done yet:

Internet Explorer: Internet Options > "Advanced" tab > Interna-
tionalUse > UTF-8 for mailto links.

Microsoft Outlook 2010: File > Options > Advanced > Interna-
tional options > Allow UTF-8 support for the mailto protocol.

Microsoft Outlook 2007: Tools > Options > Mail Format > Inter-
national options > Enable UTF-8 support for mailto protocol.

12) Click on the Save changes button.

A message informs you about the successful adoption of your changes.

13) Click on the Download button.

14) Specify by selection for which operating system type (Windows V3 or Mac 
Version) you want to provide the module files.

NOTICE:  You find the combo box for making your selection next 
to the display of the active profile and the application type full 
version/demo version.

The following page is displayed of downloading the Windows-specific 
modules:
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15) Click on the Download link next to Master module.

A file download dialog opens.

16) Click on OK in the file download dialog.

Downloading the FastMaster.exe file starts.

17) Click on the Download link next to Client module.

A file download dialog opens.

18) Click on OK in the file download dialog.

Downloading the FastClient.exe file starts.

19) Repeat this procedure as of step 14 for the Mac-specific modules you may 
require.

20) Switch to the directory in which the two files were stored after the file 
download.

21) Copy the file FastClient.exe for Windows and, if required, the archive file 
FastClient.app.zip for Mac to the directory C:\Program Files 
(x86)\WebConferenceServer of the FastViewer server.
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NOTICE:  The archive files FastMaster.app.zip and 
FastClient.app.zip to be applied on Mac systems must not be 

unpacked after they have been copied to the WebConference-
Server directory.

Providing the application files is now complete.

4.8  Perform an Update of the FastViewer Server

Execute the following steps to update the FastViewer server to a new version:

Step by Step

1) Start your web browser and enter the address of the FastViewer portal:

https://portal.fastviewer.com

2) Log on to the FastViewer portal with your license number and your password.

3) Download the current update file (Download Server-Update) for the 
FastViewer server from the portal.

Switch to expert mode > Tab: Download > Own Server Solution > 
Download: Download Server-Update.

The ServerUpdate32.zip file is downloaded.

4) Unpack this archive file.

5) Close the Webconferenceserver service.

Start > Administrative Tools > Services

6) Back up the setup directory, default path: 

C:\Program Files (x86)\WebConferenceServer

7) Copy the unpacked files from the archive and paste them into the setup 
directory.

8) Restart the service. 

Updating the FastViewer server is now complete.

4.9  Usage of Webcollaboration Apps

Perform the following steps, in order to enable the usage of Webcollaboration 
Apps in connection with WebCollaboration Server.
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Step by Step

1) Ensure, that the latest version of the Webcollaboration Server is installed. 
(Version 3.1.5829.27126 or newer)

2) It must be ensured, that in the installation directory (e.g. C:\Program 
Files(x86)\WebConferenceServer) of the Setup a subdirectory with the name 
content does exist. This directory contains the file appredirect.html which 
enusres that the App is started when the invitation link is used. 

3) In the directory content also the file conninfo.xml must exist. This file contains 
the server lists configuration. The file is available via the personal portal under 
Download > Own server solution > Download ConnectionInfo-XML. This file 
is required so that the mobile Applications can communicate with the Server.

4) the Creation is completed.

Important notes:

Participation in a Webcollaboration session: The required settings (the path to the 
Webcollaboration server) to the App are automatically transmitted to the partici-
pants, but only in case they use the invite functions in order to start a session. 

Start of a Webcollaboration session: a start of the session via the App is exclu-
sively possible if the respective license number, a user name and the related 
password are stored in the App. In Case that no user does exist or has been 
created the License number can be taken as user name and the license password 
can be taken as password. Furthermore the function alternative server must be 
enabled and the DNS name of the Webcollaboration server is stored.

4.10  Activation of the SMS Authentification

The SMS authentification is an extended security function. In order to use the 
SMS authentification from FastViewer you need first a SMS-Provider for your 
country or for the countries you want to use this service. The SMS-Provider 
provides your login data to a SMS-service. This login data is stored as follows on 
the FastViewer Server.

Step by Step

1) Add to the Settings.ini under „UserManager“ the following entry: 
SMSUrl=http://your.smsservice.com/xxxxxxxx

2) "If your SMS Provider requires a password, it can be added with the following 
entry: SMSPassword=xxxx

Important notes: The exact structure of the URL for the SMS Service needs to be 
asked by the repective SMS provider, since the structure on the manufacturer. 
FastViewer provides the following parameters in order to fill the URL with 
information: 
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Table:  Used abbreviations

Please take into account: The SMS Server can be used firstly in the User 
management as soon as the settings in the FastViewer Server are set and the 
server has established an active connection with the SMS Service. If this is not 
the case then at the attempt to store a SMS number in the user management you 
receive the following messgae: "In this country the SMS authentication is not 
supported".

4.11  Outlook Plugin Configuration on the FastViewer Server

Integrate the SSL certificate on the FastViewer server if this has not been done 
yet.

NOTICE:  To enable the FastViewer Outlook Plugin communi-
cating with the FastViewer server, an SSL certificate is required 
for using HTTPS on the server. Install the SSL certificate on the 
server and bind it to the FastViewer server with the supplied 
"Certificate Installer". The SSL certificate must be bound to the 
server via port 5100.

To configure the FastViewer server for using the FastViewer Outlook Plugin 
proceed as follows:

Step by Step

1) Update the FastViewer server to the latest version.

2) Start a suitable text editor (Wordpad).

3) Open the settings.ini file in the text editor in the path:

<drive>:\Program Files (x86)\WebConferenceServer

4) In the header area, directly under the line ExternalAddress= 

enter the following two commands in the settings.ini of the FastViewer 
server:

a) XMLRPCsecure=true

b) XMLRPCsecureFQDN=<host.yourdomain.com> (please enter the 
FQDN address of the FastViewer server for <host.yourdomain.com>).

5) Restart the "Webconferenceserver" service on the FastViewer server.

6) Release the TCP port 5100 at the FastViewer server inbound.

Variable Contents

%message% Contents of the SMS (Pin for Remote Session)

%mobile% Number of the mobile device, which contains the SMS

%p% Password of the SMS Service, which has been set in Settings.ini.
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NOTICE:  Ensure that port 5100 is also released outbound on all 
computers on which the FastViewer Outlook Plugin is installed.

7) If required, adjust the server address under Webconference Registration-
Server in the settings dialog of the FastViewer Outlook Plugin. 

Configuring the FastViewer server for using the FastViewer Outlook Plugin is now 
complete. 
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5  Installing of the FastViewer WebClient Server

This chapter describes the preparatory steps you need to take before setting up 
FastViewer WebClient on a Microsoft Server. Furthermore, it illustrates the actual 
setup process in an integrated and in a distributed deployment scenario as well 
as the configuration steps required after the installation. The FastViewer 
WebClient installation is divided into the following single steps:

• Installation of the required role services and features.

• Installation steps for the selected deployment scenario.

– Integrated deployment scenario
The FastViewer server and the FastViewer WebClient are installed on the 
same computer. (When FastViewer-Server uses a different DNS-Name 
as FastViewer WebClient, then it is necessary to adapt http-Listener)

– Distributed deployment scenario
The FastViewer server and the FastViewer WebClient are installed on two 
separate computers.

You can download the software from the customer portal anytime by specifying 
your license data, or it is supplied to you on a CD in the scope of your order.

5.1  Install required Role Services and Features

Execute the following steps to install Microsoft .NET Framework 3.5 SP1 and 
Webserver (IIS) independently from the selected deployment scenario on a 
Microsoft Windows Server 2008 R2 system.

Step by Step

1) Start the Windows Server Manager.

2) Click on the Add Roles and Features in order to start the Assistant.

The Features window section displays features already installed/activated.
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Click on Next

3) Ensure, that in the following dialog the button

role based or feature based installation is active and click on Next.

4) Select the server on which the installation should be performed and click on 
Next.
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5) Click on the checkbox Webserver (IIS) in the selection of the server roles 
continue by clicking the button Next.

6) Click on the checkbox .NET Frameworks and ASP.NET, in order to add the 
required feature. Prerequisite for the usage of the WebClient is the.NET 
Framework version 3.5 or higher.

7) Click on Next.

The dialog to the installation of the webserver (IIS) opens.

8) Click on Next.

The following dialog opens:
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Here you define which of the listed role services should be installed.

9) Take care that the following checkboxes are active:

Static Content, Default document, Directory Browsing and HTTP Errors.

10) Click on Next.

The following dialog opens:

An overview list for all selected role services to be installed is displayed.

11) Click on Install.
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The installation of the role services starts. In the following dialog the 
installation progress is displayed.

When the installation has finished the following dialog is displayed:

Information about the installation results of the selected role services and / or 
features is displayed.

12) Click on Close.

The dialog is being closed and the Assistant to add Roles and Features has 
finished.
FastViewer GmbH, 10/2019
FastViewer V3.2 Server Solution, Installation and Configuration, Manual 49



Installing of the FastViewer WebClient Server
Configuring Installation Requirements for the Integrated Deployment Scenario
5.2  Configuring Installation Requirements for the Integrated Deployment 
Scenario

Configuring installation requirements for the integrated deployment scenario.

Two installation requirements must be configured for setting up the integrated 
deployment scenario of FastViewer WebClient.

IMPORTANT:  This configuration must be performed before 
installing FastViewer WebClient on the FastViewer server.

In the following the configuration of the two installation requirements is described 
step by step.

5.2.1  Preparations for an Installation with DNS-Name / one IP-address of the 
WebConference and Web Client server

Configuration of the settings.ini on the FastViewer server for the integrated 
installation with only one IP address.

In case that a DNS-Name / one IP address is to be used, different ports must be 
defined in the settings.ini on the FastViewer server.

Proceed as follows:

Step by Step

1) Open the settings.ini file of the FastViewer server in a suitable editor. 

You find this file on the FastViewer server in the directory: 

C:\Program Files (x86)\WebConferenceServer

2)  Edit the following variables in the settings.ini to define different port 
numbers:

NOTICE:  You can use any free port. In the following example, 
port 8090 has been used.

a) ExternalAddress=<DNS name/IP>

b) ClientURLBase=<DNS name/IP>

c) WebClientURLBase=http://<DNS name/IP><alternative 
port>

3) Save the settings.ini file.

4) Reboot the Webconferenceserver service.

Now the FastViewer server is prepared for the FastViewer WebClient installation 
that both can be reached under one IP address.
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5.3  Install an integrated Deployment Scenario

In this scenario the FastViewer WebClient is installed on the same computer as 
the FastViewer server.

Prerequisites

• Microsoft .NET Framework 3.5 SP1 is already present on the FastViewer 
WebClient computer. If the required .NET Framework is not on the system, it 
will be installed during the Setup.

• The Webserver (IIS) as well as all required role services and features are 
already installed on the computer.

Perform the following steps:

Step by Step

1) Execute the WebClientV4Setup.exe file.

The following dialog opens:

2) Click on Next.

The following dialog opens in order to verify the .NET Framework :
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3) Click on Next.

If the required .NET Framework is not already on the system, it will be 
downloaded in this installation step:

4) Click on Finish.

5) the following dialog opens:
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6) Click on Next.

The following dialog opens:

7) Either use the given target folder for the installation or select the target folder 
with Choose....

8) Click then on Next.

The following dialog opens:
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9) Click on Install.

The installation starts.After a short time you will be prompted with an 
appropriate message to enter your License number and the path to the 
Webclient. (By default: C:\inetpub\webclient)

10) The WebClient V4 Administrator, which is used to create and configure the 
WebClient.
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11) Enter for the parameter ServerlistURLs under Server the existing path of 
your FastViewer server. The server specification can be done like this:

for example:

ServerListURLs=http://10.1.101.2/update/serverlist.txt

12) Adapt the FQDN of the WebClient servers. E.g.:

FQDN="webclient.yourserver.com"

13) Replace the value HTTP port 80 with another port number if the FQDN of 
the FastViewer servers and of the WebClient should be the same. E.g. port 
8090.

 

NOTICE:  Die port number specification depends on the 
respective Website-settings, which must be performed after the 
installation.

14) Save your changes with Save/Inject thus the WebClient V4 Administrator 
closes.

Activating the FastViewer WebClient is now complete.

5.3.1  Configure an integrated Scenario on IIS

This section comprises the configuration steps you need to take after installing the 
FastViewer WebClient in an integrated deployment scenario with only one IP 
address.

NOTICE:  To keep the installation simple we recommend to use 
the setup version with two IP addresses.
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Port 80 is pre-set for the IIS (Internet Information Services) by default. If only one 
IP address is used, this would conflict using the FastViewer WebClient, which 
deploys HTTP port 80 also. Consequently, you need to change the port number 
setting respectively host name in the IIS bindings configuration. Execute the 
following steps:

Step by Step

1) In the left-hand section of the Windows Server Manager window select 
Tools > Internet Information Services (IIS) Manager.

2) In the Connections section click on the plus character of the connection to 
be configured and select the Sites option.

The Sites section displays all configured websites, e.g. Default Web Site 
and webclient.

3) Select the webclient entry.

4) In the Actions section to the right of the configured websites click on the 
Bindings link.

The following dialog opens:

5) Select in the Site Bindings list the http entry.
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6) Click on Edit....

The following dialog is displayed:

7) Change one of the following values:

• The pre-set port number 80 in the Port field, e.g. to 8080.

IMPORTANT:  The port number for the web site of the FastViewer 
WebClient must differ from the port numbers for the other 
configured web sites.

IMPORTANT:  If you want to use https you can select an alter-
native port (e.g. 8443). Else you need two FQDNs,two IPs and 
two certificates

IMPORTANT:  The port numbers for the website of FastViewer 
WebClient must differ between other port numbers of other appli-
cations.

• The Host name

In this deployment scenario you need to enter here a fully qualified 
domain name (FQDN) different from the one for the FastViewer server 
computer, for example webconf2.example.com.

8) Click on the OK button.

The Edit Site Bindings dialog closes.

9) Click on the Close button in the Site Bindings dialog.

The dialog closes.

10) Click in the Actions section on the Start link (green arrow).

The weblient website is started.

11) If the installation is performed on a 64-bit system, execute the following 
additional steps:
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NOTICE:  If you install FastViewer WebClient on a 32-bit system, 
continue with step 12.

a) In the Connections section of the Windows Server Manager click on the 
Application Pools option.

To the right of the Connections section the list of the application pools 
available on the system opens.

b) Rightclick the list entry webclient.

A context menu opens.

c) Select the Advanced Settings option.

The following dialog opens:

d) Select under (General) the Enable 32-Bit Applications setting.

Value False is configured for this setting by default.

e) Use the selection button at the end of the row to change the value to True.

f) Confirm your modifications with a click on OK.

The dialog closes.

12) Open the configuration file setting.ini of the FastViewer server.

By default, this file is found under the path:

C:\Program Files (x86)\WebConferenceServer

13) Look for the following line:
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14) Replace value Change2YourServer with the external, fully qualified domain 
name (FQDN) or the IP address of the FastViewer server computer. For 
example:

or

15) Remove the semicolon (;) at the beginning of the line.

As a result, the line and thus also the parameter you have defined become 
valid.

16) Save your changes and close the settings.ini file.

17) Close the Webconferenceserver service via the Windows Server 
Manager.

18) Start the Webconference server service.

19) Enter the following URL in your web browser to check the FastViewer 
WebClient functionality:

http://<FQDN or server IP address>:<port>

The login page of the FastViewer WebClient opens. If you enter a name and 
a six digit long session number the following message must be displayed: 
"Please enter a valid session number"

5.4  Install a distributed Deployment Scenario

In this deployment scenario the FastViewer WebClient is installed on different 
servers.

Prerequisites

• Microsoft .NET Framework 3.5 SP1 is already present on the FastViewer 
WebClient computer. If the required .NET FRamework does not exist already 
on the system, it will be installed during the installation.

• The Webserver (IIS) as well as all required role services and features are 
already installed on the computer.

Perform the following steps:

Step by Step

1) Execute the file WebClientV4Setup.exe.

The following dialog opens:

;WebClientURLBase=http://Change2YourServer/joinclient.aspx?inv=%1

;WebClientURLBase=http://webconf2.example.com:80/joinclient.aspx?inv=%1

;WebClientURLBase=http://10.1.101.2:8080/joinclient.aspx?inv=%1
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2) Click on Next.

The following dialog will be opened.

3) Click on Next.

If the required .NET Framework does not exist on the computer, it will be 
downloaded.
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4) Then click on Finish.

5) The following dialog will be opened:

6) Click on Next.

The following dialog will be opened:
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7) Overtake the target folder given by default for the installation or select the 
target folder with Choose....

8) Then click on Next.

The following dialog will be opened:

9) Click on Install.

The installation is started. After a short time you are prompted to enter the 
license number and also the path to the Webclient. (by default: 
C:\inetpub\webclient)
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10) the WebClient V4 Administrator opens, which is used to create and configure 
the WebClients.

11) Enter the parameter ServerlistURLs under Server for the existing path to 
Server list of FastViewer-Server. The server can be specified like this:

For example:

ServerListURLs=http://10.1.101.2/update/serverlist.txt

12) Adapt the FQDN of the WebClient-Server e.g.:

FQDN="webclient.yourserver.com"

13) You can replace the value for HTTP Port 80 with another Port number (e.g. 
8090).
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NOTICE:  the port number specification depends on the 
respective Website settings, which need to be done after the 
installation.

14) In the Database-Connection field specify the connection to the database. This 
connection (depending on the installation) can be located e.g. on the 
FastViewer-Server. Replace in this line the string (local) with the related 
FQDN or the IP. e.g. webconf1.example.com

NOTICE:  In order to check the functionality of the database click 
on button Test DB. When the connection could be established 
successfully the following message is displayed: The database 
connection test was successful.

15) Save your changes and by clicking on the button Save/Inject WebClient V4 
Administrator is closed.

The aktivation of the FastViewer WebClient is finished

5.4.1  Configure a distributed Scenario on IIS

This section comprises the configuration steps you need to take after installing the 
FastViewer WebClient in a distributed deployment scenario.

Step by Step

1) In the left-hand section of the Windows Server Manager window select 
Roles > Web Server (IIS) > Internet Information Services (IIS) Manager.

2) In the Connections section click on the plus character of the connection to 
be configured and select the Sites option.

In the area Sites section displays all configured websites, e.g. default Web 
Site and webclient.
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3) Select the webclient entry.

4) In the Actions section to the right of the configured websites click on the 
Bindings link.

The following dialog opens:

5) Select in the Site Bindings list the http entry.

6) Click on Edit....

The following dialog is displayed:

7) Enter the FQDN name of the FastViewer WebClient computer in the 
Hostname field, for example webconf2.example.com
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8) Click on the OK button.

The Edit Site Bindings dialog closes.

9) Click on the Close button in the Site Bindings dialog.

The dialog closes.

10) Click in the Actions section on the Start link (green arrow).

The webclient website is started.

11) If you set up the installation on a 64-bit system, execute the following 
additional steps:

NOTICE:  If you install the FastViewer WebClient on a 32-bit 
system, continue with step 12.

a) In the Connections section of the Windows Server Manager click on the 
Application Pools option.

To the right of the Connections section the list of the application pools 
available on the system opens.

b) Rightclick the list entry webclient.

A context menu opens.

c) Select the Advanced Settings option.

The following dialog opens:

d) Select under (General) the Enable 32-Bit Applications setting.

Value False is configured for this setting by default.
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e) Use the selection button at the end of the row to change the value to True.

f) Confirm your modifications with a click on OK.

The dialog closes.

12) Open the configuration file setting.ini of the FastViewer server.

By default, this file is found under the path:

C:\Program Files (x86)\WebConferenceServer

13) Look for the following line:

14) Replace value Change2YourServer with the external, fully qualified domain 
name (FQDN) or the IP address of the FastViewer WebClient computer. For 
example:

or

15) Remove the semicolon (;) at the beginning of the line.

As a result, the line and thus also the parameter you have defined become 
valid.

16) Save your changes and close the settings.ini file.

17) Close the Webconferenceserver service via the Windows Server 
Manager.

18) Start the Webconference server service.

19) Enter the following URL in your web browser to check the  functionality:

http://<FQDN or server IP address>:<port>

The  login page opens. When you enter a name and a six digit session 
number the message "please enter a valid session number" must appear.

5.5  Configuration options of the WebClient Administrator

In the following you find a compilation of all settings you can possibly perform in 
the settings.ini configuration file of the FastViewer WebClient. The 
WebClient administrator can be found under the path C:\inetpub\webclient.

You can perform the settings in the settings.ini conveniently via the settings 
dialogs of the WebClient Administrator. You find this application program 
(WebClientAdministrator.exe) in path 
...\inetpub\webclient\Administrator.

;WebClientURLBase=http://Change2YourServer/joinclient.aspx?inv=%1

;WebClientURLBase=http://webconf2.example.com:80/joinclient.aspx?inv=%1

;WebClientURLBase=http://10.1.101.3:80/joinclient.aspx?inv=%1
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Description of the symbol panel:

Description of the area settings:

Subsection Description

Reload updates all values of the WebClient Administrator according to 
the information of settings.ini.

Save/Inject saves the actual settings.

Stop stops the WebClient.

Restart restarts the WebClient.

Disable Deactivates the WebClient, actual sessions are not closed but 
no new sessions can be started.

Test DB tests the connection to the database.

Update starts the update procedure.

Backup creates a zip file from the WebClient Files for safety.

Refresh updates the number of the active sessions in the overview as 
well as the version number of the server.

About informatin about the version of the WebClient Administrator.

Exit Closes the WebClient Administrator.
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Subsection Label Description

General OEM Version If set, then instead of 
the FastViewer logo 
an alternative logo is 
displayed. This must 
be stored in the 
installation directory 
of the WebClient 
server.

Enable client control Enables the transfer 
of the control per-
missions to a Web-
Client participant.

Client Queue Timeout Here the value can 
be defined in which 
time periods infor-
mation like keboard 
entries or mouse 
movements is trans-
mitted.

Use MediaServerMode Is required when 
media servers are 
used.

Disable Client Encryption This function is nec-
essary for recording 
sessions on the 
server.

Auto-Zoom at start When this function is 
active, at session 
start the whole desk-
top of the presenter 
is shown and not 
only an extract..

Reservation Check Limit Here you can specify 
the maximum num-
ber of reservations 
(session rooms) in a 
5 seconds interval 
per IP address.

Reservation Lock Duration Duration of the lock 
when the Reserva-
tion Check Limit (see 
above) has been 
reached.

Disable Video Deactivates the 
video functions of 
the WebClient. This 
results in better per-
formance.
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Server Database-Connection Contains the data-
base connection 
string inclusive user 
data for the connec-
tion establishment.

Serverlist Defines the session 
number range for the 
respective Webcon-
ference server. (E.g. 
100000-
999999:webconf1.ex
ample.com)

Serverlist URLs Contains the link to 
the server list. (E.g. 
http://
webconf1.exam-
ple.com/update/
serverlist.txt)

FQDN The WebClient 
server is reachable 
under the specified 
DNS-Name.

HTTP Port HTTP port of the 
WebClient server 
which is used for 
communication.

SSL Port The HTTPS port of 
the WebClient server 
used for communica-
tion in case that a 
repective certificate 
is available and the 
function "Use SSL" 
is active.

Use SSL Activates the com-
munication of the 
WebClient per 
HTTPS.

Redirect URL if disabled Here you can specify 
an URL for forward-
ing in case the Web-
Conference server is 
not active.

Logging Path for Logfile Here you can specify 
a path for logging 
(E.g. C:\Logs\Web-
Client.log).

Subsection Label Description
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Log to Client-Console Setting which logs 
should be displayed 
on the client con-
sole.

Log to EventLog Setting which logs 
should be displayed 
on the Windows 
EventLog.

Log to File Setting which logs 
should be displayed 
in the log-file.

Send to SysLog-Server Setting which logs 
should be sent to the 
SysLog-Server.

SysLog-Server-Adress Specification of the 
DNS-Name or IP-
address with which 
the SysLog server 
can be reached.

SysLog-Server-Port Specification of the 
IP of the SysLog-
server.

Clients Use SmartLoader If active, at start of 
the WebClient a 
Java application 
opens depending on 
configuration and 
operating system the 
Windows / MAC 
module or the Fast-
Viewer App (Apple 
and Android)

Autostart Invitations If active, at clicking 
on the invitation link 
the respective ses-
sion is started.

Default-Client for Windows Configuration which 
client should be 
used at start of a 
session via Smart-
loader on a Windows 
operating system.

Default-Client for Mac Configuration which 
client should be 
used at start of a 
session via Smart-
loader on a MacOS 
operating system.

Subsection Label Description
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Default-Client for iOS Configuration which 
client should be 
used at start of a 
session via Smart-
loader on an iOS 
device

Default-Client for Android Configuration which 
client should be 
used at start of a 
session via Smart-
loader on an Android 
device

Allow alternate Client Allows the partici-
pant to selection of 
the Client to be 
used. (WebClient or 
native).

iOS Protocol Name Protocol name which 
should be used by 
the iOS App (by 
default: ifastviewer)

iOS Appstore Link Link to the iOS App.

Android Protocol Name Protocol name which 
should be used by 
the Android App (by 
default: ifastviewer)

Android PlayStore Link Link to the Android 
App.

Path for client modules If the subscriber 
modules (FastCli-
ent.exe and FastCli-
ent.app.zip) are not 
stored in the installa-
tion directory, you 
can specify the path 
to the modules here.

Subsection Label Description
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Description of the Administrator range

Domain If the path links to a 
network drive you 
can specify here the 
respective domain. 

Username If the path links to a 
network drive you 
can specify here the 
user name with the 
respective rights.

Password If the path links to a 
network drive you 
can specify here the 
password for the 
user.

Subsection Label Description

Overview Running Sessions Displays the actual 
active connections of 
the WebClient.

Local Version Displays the actual 
active version.

Available Version Displays the actual 
latest version which 
is available.

Update Mode Value Automatic 
starts the update 
process automati-
cally. Value Manual 
requires intervention 
of an administrator.

Update Source Value Online defines 
that it is searched for 
updates online. 
Value Offline deati-
vates this search.

Update Path Path to which a 
potential update will 
be downloaded.

Service State Status of the Update 
service.

Subsection Label Description
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Beside of the configuration possibility with the WebClient administrator the 
configuration file settings.ini can be edited. An overview about the possible 
parameters are in the table below.

Advanced Settings Here you can config-
ure the intervals how 
often it should be 
searched for new 
updates. Further-
more the login mode 
at deployment of a 
new update and a 
possibility to store 
proxy information in 
order to make 
update query possi-
ble at all.

Backup Path Adaption of the 
Backup path.

Existing Backups Displays all existing 
backups with time-
stamp. There is a 
possibility to restore 
from a backup or 
delete a backup.

Log Overview and possi-
bilty to export the log 
entries.

Translation Start of the Fast-
Viewer Resource 
editor to create or 
adapt the WebClient 
administrators in dif-
ferent languages.

Subsection Label Description
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Setting Description Value specification

ClientForWin-
dows

This parameter specifies the FastViewer cli-
ent to be used for a Microsoft Windows oper-
ating system when its invitation link is 
clicked. Example:

ClientForWindows=0

0 :for clientFast-
Viewer or 

1 :for FastViewer 
WebClient (with 
JavaScript).

ClientForMAC This parameter specifies the FastViewer cli-
ent to be used for a device with MAC operat-
ing system when its invitation link is clicked. 
Example:

ClientForMAC=4

1 : for FastViewer 
WebClient (with 
JavaScript) or 

4 : with FastViewer 
Mac client.

ClientFori-
Phone

This parameter specifies the FastViewer cli-
ent to be used for a device with iOS when its 
invitation link is clicked. Example:

ClientForIPhone=3

1 : for FastViewer 
WebClient (with 
JavaScript) or 

3 : for -FastVieweri-
Phone-App.

ClientFor 
Android

This parameter specifies the FastViewer cli-
ent to be used for a device with Android 
operating system when its invitation link is 
clicked. Example:

ClientForAndroid=5

1 : for FastViewer 
WebClient (with 
JavaScript) or 

5 : for FastViewer 
Android.

ClientForOther This parameter specifies the FastViewer cli-
ent to be used for all other operating systems 
when its invitation link is clicked. Example:

ClientForOther=1

1 :for FastViewer 
WebClient (with 
JavaScript).

ClientForMo-
bile

This parameter specifies the FastViewer cli-
ent to be used for any mobile device when its 
invitation link is clicked. Example:

ClientForMobile=1

1 : for FastViewer 
WebClient (with 
JavaScript) or

2 : for FastViewer 
WebClient with 
Flash.

ClientQueue-
Timeout

This parameter defines the time in millisec-
onds after which the data in the waiting loop 
is transferred from the FastViewer WebClient 
to the FastViewer server. The default value 
is ClientQueueTimeout=300.

<value>

ControlEnabled Activates/deactivates the assignment and 
application of remote-control privileges via 
the .FastViewer WebClient This function is 
inactive by default: ControlEnabled=0.

0 or 1

DBConnection-
String

Connection character string for SQL servers. 
Example: DBConnectionString="Data 
Source=(local)\fastviewer;Ini-
tial Catalog=fastviewer;Persist 
Security 
Info=True;User ID=sa;Password=<<
xxxxxxxxxxxxxxxxxxxx>>"

<connection 
string>
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DefaultWebCli-
ent

Setting to determine whether Flash or 
JavaScript shall be used as default for the -
FastViewer WebClient. DefaultWebCli-
ent=Flash is set by default.

=Flash or =JavaS-
cript

DisableVideo This option lets you disable the video fea-
ture. This feature is active by default: Dis-
ableVideo=0.

0 or 1

DomainForPath-
ToPresaved-
Files

Domain name for a legitimation if required 
for accessing the path under PathToPre-
savedFiles.

Example: DomainForPathToPresaved-
Files="Company

<domain>

EnableLogging Activates/deactivates writing of log files. This 
parameter is inactive by default: EnableL-
ogging=0.

Logging consumes a considerable amount of 
the server system's computing power. This 
may deteriorate the system performance of 
the FastViewer server from the user's view. 
Therefore, activate this parameter only for 
the period in which you actually need this 
data to search for errors.

0 or 1

FQDN External, fully qualified domain name or IP 
address of the FastViewer server with port 
specification, e.g. 
FQDN="10.1.101.2:8080".

<FQDN>

iPhoneProto-
colName

This parameter defines which iPhone or iPod 
application you can invoke directly via the -
FastViewer WebClient link without having to 
enter a session ID manually.

The default setting is iPhoneProtocol-
Name="iFastViewer.

"iOpenScape" or 
"iFastViewer"

MAILsender Specify here the e-mail address to be dis-
played as originator address for the error e-
mail. Example: 
MAILsender="err.log@offline.com"

<e-mail 
address>

MAILreceiver Specify here the e-mail address the error e-
mail shall be sent to. Example: MAILre-
ceiver="ser.coll@offline.com"

OEMVersion This parameter defines whether or not the 
FastViewer logo shall be displayed (in case 
of an OEM (Original Equipment Manufac-
turer) version). The default setting for this 
parameter is: OEMVersion=0

0 or 1

Setting Description Value specification
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PasswordFor-
PathToPre-
savedFiles

Password for a legitimation if required for 
accessing the path under PathToPre-
savedFiles.

Example: PasswordForPathToPre-
savedFiles="Password"

<password>

PathToPre-
savedFiles

Path in which the Windows and Mac clients 
have been stored. This path must be valid for 
providing the clients as well as for the Smart-
loader function. 

Example: PathToPresaved-
Files="C:\Program Files 
(x86)\WebConferenceServer"

See also:

DomainForPathToPresavedFiles

UsernameForPathToPresavedFiles

PasswordForPathToPresavedFiles

<path specifi-
cation>

Serverlist Defines the session number range for the 
FastViewer server used, e.g. 
100000-999999:10.1.101.2. If this 
parameter is configured, the ServerLis-
tURL parameter need not be set. 

ServerListURL If the session number range is defined in a 
text file (e.g. serverlist.txt), this 
parameter specifies the storage location of 
this text file, e. g. http://10.1.101.2/
update/serverlist.txt.

<URL>

SmartDown-
loaderClient-
ForWindows

This parameter determines the FastViewer 
client application offered under a Microsoft 
Windows operating system via the Smart-
loader. The default setting for this parameter 
is: SmartDownloaderClientForWin-
dows=0

0 : FastViewer cli-
ent or 

1 : FastViewer 
WebClient (with 
JavaScript).

SmartDown-
loaderClient-
ForMAC

This parameter determines the FastViewer 
client application offered under a MAC oper-
ating system via the Smartloader. The 
default setting for this parameter is: Smart-
DownloaderClientForMAC=4

1 : FastViewer 
WebClient (with 
JavaScript) or 

4 : FastViewer 
MAC client.

SMTPPORT Specify here the port of the SMTP server to 
which you wish to transmit error reports. 
Example: SMTPPORT="<port number>"

<port number>

SMTPPWD Specify here the password of the user on the 
SMTP server to which you wish to transmit 
error reports. Example: SMTPPWD="<pass-
word>"

<password>

Setting Description Value specification
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The following applies for all parameters in the settings.ini file:

• Case sensitivity must be heeded.

• Parameter and value are separated by an equal sign.

• No blanks between parameter and equal sign

• Pre-set values exist for the respective parameter only as far as specified

5.6  Automatical Client selection - Functions of the SmartLoader

SmartLoader function.

The SmartLoader enables web conference participants to connect to each other 
independently from the operating system. In this context, an automatic version 
control makes sure that an updated client module is downloaded for the specific 
operating system, only if required.

Altogether the FastViewer server supports the following operating systems:

SMTPServer Specify here the name of the SMTP server to 
which you wish to transmit error reports. If 
you do not specify this name, sending an 
error report to an SMTP will be disabled. 
Example: SMTPServer="<server 
name>"

<server name>

SMTPUserID Specify here the name of the user on the 
SMTP server to which you wish to transmit 
error reports. Example: SMTPUse-
rID="<UserID>"

<UserID>

SysLogPort This parameter defines the port (UDP) the 
FastViewer server uses for communicating 
with the Syslog server. The default settings 
is: SysLogPort="514"

SysLogServerIp IP address of the Syslog server to which the 
generated log messages shall be sent. 
Example: SysLog-
ServerIp="100.10.0.100.100"

<IP address>

UsernameFor-
PathToPre-
savedFiles

 User name for a legitimation if required for 
accessing the path under PathToPre-
savedFiles.

Example: UsernameForPathToPre-
savedFiles="UserID"

<UserID>

UseSmartDown-
loader

Activating/deactivating the Smartloader. With 
the FastViewer WebClientand independent 
from the operating system the appropriate 
client is automatically downloaded via the 
Smartloader. The default setting is: 
UseSmartDownloader=False

False or True

Setting Description Value specification
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Without SmartLoader, every Ad-hoc web conference requires downloading the 
client that matches the operating system. If a participant has been invited for a 
web conference via an invitation e-mail, the participant's operating system is 
automatically recognized, but it will be downloaded each time a new web 
conference session is staged.

The SmartLoader remedies the above disadvantages. Only the following URL is 
now required for Ad-hoc web conferences In case of using Fastviewer communi-
cation server structure:

join. fastviewer.com

It is used for starting the session. After you have entered the session ID for joining 
the web conference, the following process starts automatically.

First the version number of the required module stored in the download directory 
is checked:

• If both versions are identical, the module starts automatically with the entered 
session ID. As a result, the module starts extremely fast to save time and 
bandwidth considerably.

• If both versions are not identical, the file of the old module will first be 
overwritten with the current module's file. Subsequently, the module starts 
automatically with the entered session ID. After the web conference the 
module is available for the faster start-up version (see above description).

The same procedure applies for web conferences started via a link in an invitation 
e-mail.

Once a web conference module has been loaded via this mechanism, the 
ensuing web conference sessions are loaded within seconds as the module file 
need not be downloaded anew. You need not wait for an update phase to pass 
until the initial start of a newly appearing module version.

Prerequisites for using SmartLoader :

To use the SmartLoader the web conference participant requires a browser that 
supports JavaScript.

NOTICE:  JavaScript-PlugIn can be downloaded for all common 
web browsers from the Java website (www.java.com).

If a participant does not have Java, he/she will be enabled to join the session 
conventionally. The client module required for the participant's system is then 
offered for downloading.

Operating system Web conferencing client

Microsoft Windows Windows client (as master module and client module)

Apple Mac OS Mac client (as master module and client module)

Apple iOS iOS-App

Google Android Android-App

Other FastViewer WebClient
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5.6.1  Configuration of the SmartLoader

Configuring SmartLoader.

Using the SmartLoader features requires the following configuration works:

Step by Step

1) Start the application Web Client Administrator by executing the program 
WebClientAdministrator.exe

You find the application program WebClientAdministrator.exe on the 
FastViewer server in the directory inetpub\webclient\Administrator 

2) In the Web Client Administrator, switch to the Clients tab.

3)  Activate the Smartloader by setting the option Use Smartloader.

4) Select the clients you wish to use.

a) Select the client for Windows systems from the Client/Windows combo 
box:

- Windows, for using the Windows-based client module.

- Web, for using the web-based client module.

b) Select the client for Mac systems from the Client/MAC combo box:

- MAC, for using the Windows-based client module.

- Web, for using the web-based client module.

5) Save your settings with a click on Save Settings.

6) Enter in the field path for client module the path C:\Program Files 
(x86)\WebConferenceServer. Make sure that the modules 
(FastClient.exe and FastClient.app.zip) are available under this path.

Performing the SmartLoader settings is now complete. The SmartLoader is now 
active too. 
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6  Activating the https support

Enabling a secure https connection for the FastViewer WebClient or FastViewer-
Server.

NOTICE:  The certificate required for the secure https connection 
must be valid and equipped with a "private key"!

Else https connections are not possible!

At the installation the system intern Web Client is installed by defaut without https 
support.. 

Using a secure https connection can be retrospectively enabled via installing SSL 
certificates on the IIS web server that hosts the client interface as well as on the 
FastViewer server. In case of Web Client and FastViewer are reachable with 
different DNS names, so in this constellation two SSL-certificates are needed.

When the SSL certificate installations are complete, the FastViewer WebClient 
can use a secure https connection to the FastViewer server.

Execute the following steps for this purpose:

• Add the certificates to the store of the own certificates for all FastViewer 
servers used, if you wish to use an internal root certification authority. 

• Install the server certificates for the IIS web server.

• Usage of a SSL Certificat in FastViewer WebClient: In the IIS Web Server and 
WebClient Administrator activate the https-Unterstützung.

• In order to use a SSL Certificat for a FastViewer- Server: Perform in the 
settings.ini the Configuration settings for the FastViewer-Server.

In the following sections we detail how to proceed in the single work steps.

6.1  Add a SSL Certificate

Step-by-step guide to adding a certificate to the Trusted Root Certification 
Authority.

NOTICE:  You find further information about this procedure under:

http://technet.microsoft.com/en-us/library/
cc754841.aspx

To add a certificate to the store of the Trusted Root Certification Authority if you 
wish to use an internal root certification authority proceed as follows:

Step by Step

1) Open the Management Conole.

E.g. via execute. Enter mmc and confirm with return key
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2) In the Management Console open the File menu and select the Add/
Remove Snap-In function.

The Add or Remove Snap-ins dialog opens.

3) Select in the Available snap-ins area the Certificates snap-in and click on 
Add.

4) Select in the Certificates snap-in dialog under This snap-in will always 
manage certificates for: the Computer account option and click on Next.

5) Select in the Select Computer dialog the Local computer option and click 
on Finish.

The Select computer dialog closes.

6) Click on OK.

The Add or Remove Snap-ins dialog closes.

7) Expand in the console structure the Certificates entry.

The certificate objects are displayed.

8) Open the context menu of the object Own Certificates with a click of the right 
mouse button.

9) Select All Tasks > Import to import the certificates.

Now follow the steps through the Certificate Import Wizard dialog.

10) Repeat this procedure for all available FastViewer servers.

6.2  Activation of the https Support of the FastViewer Server

Step-by-step guide to activating https support on the FastViewer server.

To activate https support on the FastViewer server proceed as follows:

Step by Step

1) Open the Certificate installer which is located under C:\Program Files 
(x86)\WebConferenceServer.

The dialog to the installation of FastViewer-Server-Certificate will be opened.

2) Click on Select cert. 
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The dialog opens in which you can select the supplied own certificates.

3) Mark the certificate and confirm with a click on OK.

4) Enter under IP Address the IP address of FastViewer Server.

NOTICE:  You can also use the combo box to enter the IP 
address. 

5) Click on Install Cert.

The selected certificate is installed.

https support is now installed on the FastViewer server. Further information can 
be found in Chapter 7.1 Certificate Installer.

6.3  Activation of the https Support in the Internet Information Server (IIS)

Step-by-step guide to activating https support and configuring the binding port on 
the IIS server.

To activate https support and configure the binding port on the IIS server proceed 
as follows:

Step by Step

1) Click on Start.

2) Click on Administrative Tools. 

3) Start the Server Manager.

4) Expand the console structure Roles. 

5) Expand Web Server IIS.

6) Expand Internet Information Services (IIS) Manager.

7) Expand on the right side under Connections the IIS server entry (computer 
name). 

8) Expand Sites.

9) Open the webclient context menu with a click of the right mouse button and 
select the Edit bindings function.

The dialog for configuring the binding port Site Bindings opens.

10) Select Add.

The Edit Site Bindings dialog opens.

11) Enter in the configuration dialog the binding type https under Type.

12) Enter the IP address assigned to FastViewer WebClient in the configuration 
dialog under IP Address.
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NOTICE:  Be sure to actually enter the IP address of FastViewer 
WebClient and not the one of FastViewer Server.

13) Enter in the configuration dialog port 443 under Port.

NOTICE:  You can also use any other port here. This port infor-
mation is automatically transmitted to all Web Client subscribers.

14) Select under SSL Certificate the certificate you have previously installed.

15) Click on OK to complete defining the binding port.

The Edit Site Bindings dialog closes.

16) In the Site Bindings dialog click on the Close button.

17) Select on the right side under Connections the IIS server entry (computer 
name).

18) Select on the right side in the action area under Manage Server the Restart 
function.

Activating https support and configuring the port on the IIS server is now 
complete.

6.4  Configure the FastViewer Server for the https Connection via a 
WebClient

Step-by-step guide to configuring the FastViewer -WebClient for the https 
connection.

To configure the FastViewer WebClient for the https connection proceed as 
follows:

Step by Step

1) Open the file WebClientV4Administrator.exe under the path

C:\inetpub\webclient\Administrator in order to start the the 
WebClient administrator

2) click under Settings on Server and activate the function Use SSL in order to 
click on the checkbox. In the field SSL Port specify the used port number.

3) Now save and perform for the FastViewer-Server a restart: 

a) Click on Start.

b) Click on administrative tools.

c) Start the Server-Manager.

d) Expand in the structure of the console Configuration.

e) Mark Services.
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f) Scroll in the list of services until Web Conference Server and open via 
right click for this service the context menu.

g) Select from the context menu restart.

The Configuration of the FastViewer-Servers for https-suuport is finished. From 
now on Web conference sessions take place via a secure https-connection.

6.5  Steps for exclusive usage of https

Step-by-step guide for the general usage of https instead of http (port 80) Thus 
for communication with FastViewer https or tcp port 5000 is used exclusively.

Step by Step

1) It must be ensured that the steps of Chapters 6.1 and 6.2 have finished 
successfully. These Chapters describe the creation and activation of the SSL 
certificate and thus the base for the basically usage of https.

2) Öffnen Open the server list serverlist.txt which can be found under 
C:\Program Files (x86)\WebConferenceServer.

3) Complete the repective IP-addresses/DNS-Names by adding after the 
session number a double point (:) and https:// e.g..

a) For the usage of FastViewer-Servers:

100000-999999:https://10.1.101.2

b) For the usage of several FastViewer-Server:

100000-299999:https://10.1.101.2

300000-599999:https://10.1.101.3

600000-999999:https://10.1.101.4

The server list is invocable with https://Servername/update/serverlist.txt.

4) Start the ServerAdmin under C:\Program Files (x86)\WebConferenceServer.

a) Click on Change Serverlist.

b) click on tab Use Serverlist URL.

c) Modify the URL from http:// to https://

d) In order to ensure the functionality of the link click on Validate url.

5) Confirm the performed changes by clicking on the Submit Changes Button. 
Click in the following window on Yes in order to transfer the changes. If there 
is no internet connection click on No. In this case please send the created 
ServerAdmin.fvk to support@fastviewer.com. After adaption of the server list 
you will receive an inforamtion per mail.

Please download again the modules via your personal portal. Now https and / or 
tcp will be used exclusively for the Communication to/from FastViewer-Server. 
The configuration / creation of https on the WebClient is described in the Chapters 
and 6.3 and 6.4.
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7  Administrative Tools

Administrative tools for the FastViewer server

This section describes the administrative tools used for connecting SSL certifi-
cates as well as for analyzing and maintaining. They are not required for normal 
use of the FastViewer server.

The following tools are available:

• Certificate Installer
Tool for connecting SSL certificates. 

• Server Admin
Tool for analyzing the server status.

• Log Viewer
Tool for representing logs.

7.1  Certificate Installer

Tool for connecting SSL certificates. 

If you wish to encrypt the communication during a web conference session you 
need to have a valid SSL certificate for the IIS. The Certificate Installer serves for 
connecting SSL certificates to the corresponding FastViewer server addresses.

You reach such tools via C:\Program Files (x86)\WebconferenceServer\Certif-
icate Installer.

The GUI of this tool offers the following operating elements and functions:

• IP Address/Port
Enter here the IP address and the Port to which the SSL certificate shall be 
bound to. Alternatively, you can select the IP address manually via the 
opposite combo box.

• Clear all
A click on this button deletes your entries.

• Select cert
After clicking this button you can select the SSL certificate to be bound to the 
IP address mentioned under IP Address. The certificate name appears to the 
right of Certificate. In addition, the finger print of your SSL certificate (the so-
called hash value) appears to the right of Fingerprint.
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• Remove cert
Via this button you can separate the SSL certificate from the IP address 
defined above.

• Install cert
After you have made all required entries, a click on this button binds the 
selected SSL certificate to the specified IP address.

7.2  Server Admin

Tool for analyzing the server status.

This is a browser-based tool that enables displaying the server or database 
status, the number of currently started sessions and the connected client 
modules. You can also use it for displaying the current server configuration 
(settings.ini).

You reach this tool via browser.

Enter http://localhost/admin.

Clicking one of the following buttons represented in the left-hand section of the 
page you can have the corresponding information displayed:

• SYSTEM STATUS
This page is displayed by default when the Server Admin starts. It contains 
general information about the server (e.g. server name, session ID range), 
network information (e.g. type (direct, via HTTP or HTTPS) and number of 
connections), server status: active/inactive.

• CURRENT SESSIONS
A click on this button displays all current sessions.
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• CONNECTED CLIENTS
After clicking this button you receive an overview of all currently connected 
clients.

• DATABASE STATUS
The single entries in the Table column can be exported or displayed in the 
XML format. Such information is exclusively important for support purposes.

• VIEW CONFIGURATION
Enables a fast overview of the server settings contained in the 
settings.ini configuration file.

7.3  Log Viewer

Tool for representing logs. 

Log Viewer

With the Log Viewer tool you can gain an overview of all staged sessions. It 
provides useful information about sessions in tabular and graphical format 
anytime. In addition, this tool enables you to sort connection or session details by 
various criteria and execute an export in the CSV format.

You reach this tool via C:\Program Files (x86)\WebconferenceServer\Log 
Viewer.

The Log Viewer is divided into four tabs:

• Connection Log
This tab lists the following information about all established connections in 
tabular format:

– Serial-No

– Computername of the moderator

– Session number

– Start-Time of a session

– End-Time of a session
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– Duration/min

– Internal IP address of the moderator

– External IP address of the moderator

– External IP Client

– number of Participants

– Start-Info entered at the beginning of the session

– End-Info entered at the end of the session

– Windows user name of the moderator

– Customername (only if specified in the moderator module)

– RE Username - user name if the FastViewer Secure Advisor is used

– RE Computername - name of the accessed computer

– RE-Info 1-9

– Broken - if the session has been cancelled because e. g. of a dropped 
connection, a tick is placed in this column for the cancelled session.

You can also toggle Universal time (UTC) and Local time.
With the help of a conversion function you can request an evaluation by €/$ 
amounts. Simply enter the desired minute rate in the Cost $/min. field, then 
click on Show.
You can group the above information by column. Drag the corresponding 
header of a selected column into the bar positioned directly on top of the tabs 
with the left mouse button kept pressed. The following figure shows data 
grouped by session number.

• Session Log
This tab lists the following information about all held sessions in tabular 
format:

– Serial-No - serial number of the purchased license

– Session-No - session number

– Event-Time - start time of the session

– Source 

– Target 

– Service 

– Information

– Info 1-5
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– Message type

• Diagram "Number of Sessions"
This tab provides a graphic overview of the sessions held in a previously 
defined period, so that performance peaks can be detected early. On the x-
axis you can see the selected period and the y-axis displays the number of 
sessions held in parallel respectively the number of participants.

• Diagram "Number of Participants"
This tab provides a graphic overview of the involved participants in a previ-
ously defined period, so that performance peaks can be detected early. The 
x-axis displays the selected period and on the y-axis you can see the number 
of participants. 

You can determine the period in which logging information is displayed on each 
of the four tabs. Use the fields Date from and to in the tab's top section for this 
purpose. After you have clicked on Show, the desired data is evaluated and 
subsequently displayed on the current tab.
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